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Before You Begin

System requirements

Check the Expression Studio package to make sure that your 
computer meets the minimum system requirements. 

Product key

Find your 25-character product key on the disc holder inside 
the Expression Studio package. Type the key when prompted.

Internet connection

If you plan to install additional components or get more infor-
mation about Microsoft Expression® products, make sure that 
you have a working Internet connection.
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Installation Instructions

1.	 Insert the Expression Studio DVD into your computer’s DVD 
drive. If the installation doesn’t start automatically, browse 
to the disc drive, right-click the drive name, and then do 
one of the following:

On Windows Vista® or Windows 7, click Install or run 
program.

On Windows® XP, click AutoPlay.

2.	 Follow the on-screen instructions to install individual 
Expression programs or the entire Expression Studio.

Troubleshooting installation

If you experience problems during installation, go to Microsoft 
Help and Support (http://support.microsoft.com/oas) for more 
information or assistance.

•

•
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Welcome to  
Expression Web 3

Microsoft Expression Web 3 is a program for designing, devel-
oping, and publishing compelling, feature-rich websites that 
conform to web standards. Whether you’re a web designer, a 
web developer, or a visual design professional, Expression Web 
can help you bring your designs to the web. These are some of 
the key features:

Web authoring   Create complete, standards-based sites. 
In addition to HTML and CSS, Expression Web supports 
ASP.NET, PHP, and AJAX.

SuperPreview   Compare your pages in multiple browsers 
simultaneously. Overlay views from two different browsers 
to troubleshoot layout and positioning errors.

Snapshot   See actual browser views of your page, using any 
browser installed on your computer, right in Expression Web.

Publishing   Publish your sites quickly and securely with 
multiple files transfer streams and secure FTP.

Media   Add interactive Microsoft Silverlight™ applications. 
Encode and add Silverlight videos. Import Deep Zoom 
photo compositions and Adobe Photoshop images to your 
pages.

For a complete list of new features, see “What’s new” in the  
Expression Web User Guide (on the Help menu).

•

•

•

•

•
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Explore the New Workspace

The Expression Web workspace integrates seamlessly with the 
rest of Microsoft Expression Studio, while retaining the features 
that you’ve come to depend on.

For more information, see “Configuring your workspace” in the 
Expression Web User Guide.

1	 Menus and toolbars
Eleven toolbars, organized by 
groups of related tasks, are 
available on the View menu.

2	 Editing Window
The central area of the work-
space is for editing pages. 
You can build and edit pages 
visually in Design view, which 
displays details such as margin 
and padding of elements. Or 
you can use Code view to edit 
HTML markup directly and fix 
errors. Split view shows Design 
and Code views at the same 
time.

3	 Status Bar
The status bar shows you infor-
mation about your page and 
program settings. If your page 
contains an error, an icon in the 
status bar lets you know and 
can take you right to the prob-
lematic code.

4	 Panels
The default workspace shows 
6 of the available 20 panels. To 
customize your workspace, you 
can “unpin” a panel so that it 
is automatically hidden when 
you’re not using it. You can 
drag a docked panel away from 
the program to display it in a 
floating window, or dock it in 
another location.
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Test Cross-Browser Compatibility with  
SuperPreview

Expression Web provides new tools to help make sure that 
the pages in your site work in multiple browsers. Using 
SuperPreview, you can set the baseline to your design browser, 
and then preview and compare pages simultaneously in mul-
tiple browsers, even in multiple versions of Windows Internet 
Explorer®. You can also compare browser views against a 
comprehensive layout (comp) image.

You can select an individual element in a page and see details 
about the selected element, helping you quickly find and fix 
cross-browser layout and positioning errors.

For more information, see “Using SuperPreview” in the 
Expression Web User Guide.
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1	 Toolbar
Choose the HTML page you 
want to preview, select the com-
parison and highlighting view 
modes, and turn the thumbnail 
display and positioning guides 
on and off.

2	 Vertical-split Layout 
View
Select an element in any open 
browser view or DOM view to 
highlight it. You can also use the 
horizontal-split layout view to 
display browser views in a verti-
cal stack, or the overlay view to 
display both browser views in 
the same window.

3	 Browser Selection
Choose which browser to display 
in each view pane. You can add 
up to eight different browsers 
(any installed version of Internet 
Explorer or Mozilla Firefox) in 
the view pane on the right, and 
switch between them.

4	 Dom View
See where an element is in the 
Document Object Model (DOM) 
tree. If you’re using the vertical-
split or horizontal-split layout 
views, you can select an element 
in either browser view, and the 
DOM view will be updated to 
display the attributes for the 
selected browser view. Or, 
you can select an element in 
the DOM view to update the 
browser views.

5	 Element Attribute	
display
Select an element in a browser 
view. The size and position at-
tributes of the selected element 
are displayed, along with its ID 
or class name (if it has one).

6	 Browser View Size
Select a fixed browser view size 
to compare how your pages 
render at different resolutions.
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Use Overlay Layout View for Pixel-Perfect Pages
In the Overlay Layout view of SuperPreview, you can compare 
how your page displays in two browsers at once. The Overlay 
Layout view “stacks” two browser views and helps you trouble-
shoot positioning errors down to the pixel.

1	 OVERLAY Layout VIEW
The two browser views are 
“stacked,” showing you any dif-
ferences in how the browsers 
render each element.

2	 ELEMENT POSITION	
DISPLAYS
The actual browser position 
and the size of the selected 
element are displayed for each 
browser view.

3	 BROWSER SeLECTORS
Select the base browser and up 
to eight comparison browsers. 
Quickly switch back and forth 
between comparison views 
with a single click.
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Preview Pages Inside Expression Web
In the Snapshot panel, you can see how your page renders in 
the browser of your choice without leaving Expression Web. 
You can also move and dock the Snapshot panel wherever you 
like. Every time you save your page, Expression Web updates 
the Snapshot panel view to show you your changes. For more 
information, see “Preview pages in Snapshot” in the Expression 
Web User Guide.

1	 Snapshot browser	
selector
The browser selector allows 
you to choose what browser 
the Snapshot panel will use to 
generate a preview.

2	 Snapshot panel
The Snapshot panel displays 
your page as rendered by the 
selected browser.

3	 Snapshot browser	
window size selector
Choose the browser window 
size for the Snapshot panel.
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Publish Files and Manage Sites with Ease

Publish with Enhanced FTP

When you publish your files, Expression Web automatically 
transfers several files at a time instead of transferring them 
one by one. You can also publish your files securely, using FTPS 
or SFTP. For more information, see “Publishing Sites” in the 
Expression Web User Guide.

Publish Sites Quickly and Securely

You can manage multiple sites and remote locations. 
Publishing files is fast and reliable, and you can publish the 
same site to different destinations. Configure multiple pub-
lishing destinations to let you publish a single site to many 
locations more easily. You can publish a site to a staging web 
server for testing, and then publish to a production server. For 
more information, see “Publish files” in the Expression Web 
User Guide.

Manage Multiple Sites

Using Site Manager, you can add and remove sites from the 
list that Expression Web displays when you click Open Site. For 
more information, see “Working with sites” in the 
Expression Web User Guide.
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1	 Publishing Toolbar
This toolbar contains shortcuts 
for tasks such as selecting, con-
necting to, or creating a new 
publishing destination.

2	 Publishing Site View
The left pane displays the files 
in your site (depending on the 
View setting). The right pane 
displays the files at your select-
ed publishing destination. The 
buttons in the middle publish, 
download, or synchronize files 
between the two.

3	 Publishing Status Panel
The bottom pane shows file 
transfer status and logs.
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Add Deep Zoom and Silverlight Media

You can add applications that are built with Silverlight to your 
pages. And with Deep Zoom support, you can create and add 
interactive Deep Zoom photo compositions that work with 
either Silverlight or Seadragon Ajax.

Expression Web also helps you create web-optimized versions 
of your Silverlight videos using Expression Encoder and add 
them to your page. You can even choose a “skin” to customize 
how the video player appears on your site.

For more information, see “Add a Deep Zoom image to a page” 
and “Add Silverlight video to a page” in the Expression Web 
User Guide.

1	 Deep zoom Import
Choose Silverlight for perfor-
mance or Seadragon Ajax for 
cross-platform capability.

2	 silverlight video
Select a video to import and 
choose encoding options.

3	 Published Media
Publish Silverlight Video and 
Deep Zoom images to your site.
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Import Photoshop Images

When you import Photoshop images into a page, you can 
select a custom area of a Photoshop image to import, and 
even use Photoshop alignment guides to help define the cus-
tom image area. Alternatively, you can import the entire image 
canvas, including transparency and layer effects. You can drag 
a Photoshop image into your page to quickly import it.

If you make changes to your imported Photoshop images, you 
can reimport your Photoshop file into Expression Web, retain-
ing your layer and conversion settings.

For more information, see “Importing Photoshop images” in 
the Expression Web User Guide.
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1	 Preview pane
The preview pane displays the 
image as it will appear in your 
page.

2	 Preview size
You can use the preview size to 
see more detail in the image 
that you want to import.

3	 Layer selector
You can use the layer selector 
to choose which layers will be 
included in the final imported 
image.

4	 Encoding
You can use the encoding con-
trols to choose whether to 
import the image as a PNG, 
JPG, or GIF image. If you 
choose JPEG, you can also 
choose the final image quality.
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Welcome to  
Expression Blend 3 

Microsoft Expression Blend™ 3 is an interaction design program 
for creating websites and applications based on Microsoft 
Silverlight and Windows Presentation Foundation (WPF). 
These are some of the key features:

SketchFlow   Create a working prototype that can be as 
rough or as real as you want it to be, replacing traditional 
approaches to prototyping such as using static comps or 
HTML click-throughs.

Design workflow   Import Adobe Photoshop and Adobe 
Illustrator files, speed up your work with artboard enhance-
ments, and create animation with new features such as 
easing functions.

Sample data   Use sample data while you design data-con-
nected applications, presenting a quick way to create the 
most commonly used controls for a particular data type, 
and switch to a live data source at any time.

Behaviors   Design custom and interactive visual experiences 
without writing code by using behaviors, prepackaged, re-
usable chunks of code that you can drag onto an object to 
create instant interactivity. You can even create your own 
behaviors by using the new SDK and toolkit.

Coding and IntelliSense   Modify code-behind files in a 
code editor in Expression Blend, while IntelliSense suggests 
endings to keywords as you type in both the code and 
XAML editors.

For a complete list of new features, see “What’s new” in the  
Expression Blend User Guide (on the Help menu).

•

•

•

•

•
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Explore the New Workspace

Customizing Your Workspace

You can craft your ideal workspace by moving, resizing, float-
ing, or collapsing panels. You can use AutoHide to minimize 
all panels, and then move your pointer over a panel to show it 
again temporarily.

Managing Workspaces

Expression Blend has two preset workspace configurations: 
Design and Animation. However, you can also save a favorite 
workspace configuration that you can use in the future. Save as 
many workspace configurations as you want, and then quickly 
switch between those workspaces when you want to.

Views

Expression Blend has three working views:

Design view   Changes the artboard to the visual design 
view of your document. In this view, you can work directly 
with visual objects on the artboard.

XAML view   Changes the artboard to XAML view. In this 
view, you can edit XAML code manually.

Split view   Changes the artboard to a panel layout that 
shows both Design and XAML views. When you select an 
object, the respective line of XAML is highlighted.

For more information, see “Adjusting your workspace” in the 
Expression Blend User Guide.

•

•

•
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1	 Artboard
Displays the visual design of a 
document in your application.

2	 Tools panel
Provides the tools you use 
when you work in Design view, 
such as selection, drawing, and 
object tools.

3	 Assets panel
Displays available controls, lo-
cal styles, media, effects, and 
behaviors that you can add to 
the design surface.

4	 Project and Resources 
panels
Displays the files in your proj-
ect, references to assemblies 
that contain controls, effects, 
and behaviors that you can use, 
and lists reusable resources that 
you can apply to objects.

5	 Properties panel
Lists the properties of selected 
objects on the design surface.

6	 Objects and Timeline
Lists the objects that are on the 
design surface. Use the timeline 
to animate objects.
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Prototype with SketchFlow

With SketchFlow, the new prototyping feature in Expression 
Blend, designers can quickly and easily create an interactive 
map that represents the flow of an application. The map (a 
prototype project) consists of any number of “screens”: virtual 
whiteboards on which you can use sketch-styled controls or 
insert any of the existing user interface (UI) modeling features 
of Expression Blend to build a UI. You can also use screens 
to create reusable elements such as logos, backgrounds, or 
UI templates, and then include those screens as elements in 
other screens.

SketchFlow prototypes are real Windows Presentation Founda-
tion (WPF) or Microsoft Silverlight applications. You can build a 
prototype project, run it, and then navigate through it, even if 
you have only initial sketches of your prototype.

You can also create design documentation that contains im-
ages of every screen and state from your SketchFlow prototype 
by exporting your prototype to a Microsoft Office Word docu-
ment. Use the tools in Expression Blend, including animation, 
visual states, behaviors, and sample data, to create powerful, 
compelling prototypes that can be as close to real applications 
as you want them to be.

For more information, see “Prototyping with SketchFlow” in the 
Expression Blend User Guide.
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1	 artBOARD
The artboard gives you a view 
of individual screens on which 
you can draw wireframes with 
any of the drawing tools in 
Expression Blend, add controls 
from the Assets panel, or im-
port images from applications 
such as Photoshop or Microsoft 
Office PowerPoint®.

2	 Annotations
You can use the SketchFlow 
Player to gather feedback at 
run time, and then see that 
feedback in the Feedback 
panel in design time. You can 
also add annotations to your 
prototype in design time.

3	 SKETCHFLOW MAP Panel
The SketchFlow Map panel is 
a visual representation of the 
application workflow, begin-
ning with the first screen and 
following the user interaction 
through the application flow.
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Create an Application Flow

You can easily sketch out a simple application flow in the 
SketchFlow Map panel, which appears at the bottom of the 
Expression Blend window when you’re working in SketchFlow. It 
doesn’t appear when you are working on other types of Expres-
sion Blend projects.

1	 SketchFlow Map Tools
Use the options available to each 
screen or the options at the bot-
tom of the SketchFlow Map 
panel to add or remove screens 
or to customize the appearance 
of the application flow in the 
SketchFlow Map panel.

2	 Screens
Screens represent UI elements 
such as dialog boxes or pages 
throughout an application or a 
website.

3	 NAVIGATION CONNECTIONS
Navigation connections imply  
navigation between two 
screens. In the SketchFlow 
Player, navigation connections  
simulate the navigation  
between screens in the 
Navigation panel.

4	 Component connections
Component connections rep-
resent the locations where a 
component is reused through-
out the prototype.

5	 COMPONENT screens
Component screens allow 
designers to create com-
ponents that can be reused 
throughout the prototype.
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Create Content on the Artboard

The artboard gives you a view of individual screens on which you 
can draw wireframes with any of the drawing tools in Expression 
Blend, including SketchFlow styled controls. You can also import 
images from Photoshop to use as a starting point, and use the 
full range of controls available in Expression Blend for WPF and 
Silverlight applications. SketchFlow styles allow you to focus on 
the interactive design, rather than on the graphic design, in the 
early stages of prototype development. You can also use anima-
tions to illustrate how the user will interact with the application.

1	 INTERACTIvity
You can add interactivity to 
a prototype by creating ani-
mations, adding behaviors to 
screens and to individual ele-
ments on the screen, and using 
sample data to prototype data-
driven user interfaces.

2	 SKETCHFLOW STYLEd	
controls
SketchFlow styled controls, 
controls with a hand-sketched 
look, help reviewers focus on 
user interaction rather than on 
graphic design.
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Run Your Prototype

Once you have created a prototype in SketchFlow, you can 
build the project, and then view it in the SketchFlow Player, 
a runtime environment that runs the SketchFlow project as it 
was designed. 

SketchFlow makes this possible by running the prototype in 
a stand-alone player that lets you click through the proto-
type, change states within your UI, and run animations. The 
SketchFlow Player also makes it easy to distribute your proto-
type to reviewers and collect feedback. You can draw directly 
on the prototype, and also add comments. Feedback col-
lected in the SketchFlow Player can be viewed in Expression 
Blend, where it can then be evaluated and implemented by 
the designer.

SketchFlow prototypes are fully functional Silverlight or WPF 
applications, which means that the prototypes themselves 
function in the same way as the final application will when it is 
built in either Silverlight or WPF.
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1	 NAVIGATe PANEL
You can navigate through a 
prototype by clicking through 
the screens in the Navigate 
panel.

2	 FEEDBACK PANEL
You can leave text feedback 
for the designer by using the 
Feedback panel. Ink and high-
lighting tools can be used to 
mark up the screen.

3	 Map PANEL
You can view the SketchFlow 
map in the Map panel, or use 
the command to display the 
SketchFlow map as an over-
lay on the SketchFlow Player 
window.

4	 Interactive Controls
You can interact with fully 
functional controls, such as 
buttons, lists, and menus, 
all while you are using the 
SketchFlow Player.
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Import Photoshop and Illustrator Files

You can import Photoshop (PSD) and Illustrator (AI) files 
directly into your Expression Blend project. Many features in 
the original file are preserved during import, including gra-
dients, vector layers, adjustment layers, and text objects. The 
XAML that is generated from the imported file is optimized 
to keep the file size at a minimum. For more information, 
see “Import Adobe Photoshop and Illustrator files” in the 
Expression Blend User Guide.

1	 Preview Pane
Preview the art that will be 
imported.

2	 photoshop layers
Select layers to import. 
Optionally merge layers that 
contain masks or unsupported 
features.

3	 compatibility layer
Include a layer that represents 
all layers merged into one.
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1	 Original art
View art as it appears in  
Photoshop.

2	 Imported art
View the same art as it appears 
in Expression Blend.

3	 Layers
Expression Blend preserves 
layer names, importing the 
layers as individual objects 
or layout containers to make 
them easy to work with.
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Use Sample Data to Design  
Data-Connected Applications

It’s much easier to style objects that display data if you can 
actually see data in those objects. With Expression Blend, you 
can create sample data that you can see on the artboard. To 
create sample data, you can either import an XML file or define 
a schema in Expression Blend from which sample data values 
will be generated for you. 

To display data, simply drag data objects onto objects on the 
artboard. Expression Blend also makes it easy to create mas-
ter-detail visualizations and to work with sophisticated data 
controls like the DataGrid and TreeView.  

The sample data system in Expression Blend lets you gener-
ate data-connected applications by making the data available 
at runtime for testing purposes, and by providing the ability to 
seamlessly switch between sample and live data sources during 
various stages of an application’s development cycle. 

For more information, see “Creating Sample Data” in the 
Expression Blend User Guide.

1	 sample data
View and modify a collection of 
sample data in the Edit Sample 
Values dialog box.

2	 binding data
To display data, drag a col-
lection of data onto an object 
such as a ListBox that has been 
customized to appear circular.

3	 Displayed data
Expression Blend interprets 
data values to determine the 
best way to display the data. 
For example, string data is dis-
played in TextBlock objects.



31



32

Use Behaviors to Add Interactivity Without Code

You can use behaviors to add interactivity to your applica-
tion without having to write any code. Behaviors are reusable 
pieces of packaged code that can be dragged onto any object, 
and then fine-tuned by changing properties. Instead of being 
limited to controlling storyboards or defining the appearance 
of controls, you can bring your application to life using the 
standard behaviors that come with Expression Blend, or those 
that are created by people in the Expression community. For 
more information, see “Adding behaviors to objects” in the 
Expression Blend User Guide.

Download custom behaviors from the Expression Gallery at 
http://gallery.expression.microsoft.com. Developers can use the 
new Expression Blend Software Development Kit (SDK) to cre-
ate custom behaviors.

1	 Behaviors in the Assets 
panel
Drag one or more behaviors 
onto the objects in your ap-
plication.

2	 Behavior properties in 
the Properties panel
Fine-tune an applied behavior 
by setting its properties.

3	 The Behavior in Action
Rotate the mouse wheel to see 
the WheelSpinner behavior 
move the Center grid object.
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Create New Controls from Scratch

If you want to create a reusable control from scratch, designing 
both its appearance and its behavior, you can make a user con-
trol. To design its appearance, you can draw everything on the 
artboard by using drawing tools, and by importing art and other 
assets. You can convert any objects into a new user control.

To design the interactivity of your user control, you can define 
a different visual appearance for each state that your control 
can be in. You can create animations that will occur when the 
control is in a state or when changing between states. To make 
the user control change states in response to user interaction, 
you can drop a prepackaged behavior onto your control so 
that you don’t have to write any code. For more information, 
see “Designing a user control from scratch” in the Expression 
Blend User Guide.

1	 modifying the user 	
control
Define and design the differ-
ent states that your control 
can exist in.

2	 adding a behavior
Use the GoToStateAction 
behavior to change states 
when an event occurs, such as 
when the user clicks part of the 
control.
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Customize Existing Controls

Expression Blend comes with many WPF and Silverlight con-
trols that you can use to create a great user experience. If you 
find a control that functionally fits your needs but doesn’t look 
the way that you want it to, you can modify its template. Focus 
on your design by drawing everything on the artboard first, 
by using drawing tools, and by importing art or other assets. 
When you are done, you can convert your objects into a tem-
plate for any control. Because the template affects only the 
appearance of the control to which it’s applied, the interactiv-
ity of the control remains the same. For more information, see 
“Styling a control that supports templates” in the Expression 
Blend User Guide.

1	 original objects
Select any group of objects to 
make them into a new tem-
plate for a control.

2	 Make into control 	
dialog box
Select the type of control to 
make a template for.

3	 modifying the template
Modify the template by add-
ing and removing objects. You 
can also define different visual 
states, add behaviors, and 
change the parts that objects 
will play in the template.
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Welcome to  
Expression Encoder 3

Microsoft Expression Encoder 3 is a program for creating high-
quality audio and video that you can play back, or stream, 
seamlessly from the web. Expression Encoder integrates excep-
tionally well with the rich-media, interactive-presentation 
capabilities of Microsoft Silverlight, and also with the newest 
streaming technologies available. This version adds the abil-
ity to record your on-screen actions with Screen Capture, and 
refines your ability to use and customize H.264 compression. 
This version also uses improved Internet Information Services 
(IIS) Smooth Streaming features and multiple–bit-rate encod-
ing to ensure that you present high-quality content wherever 
it is viewed. Expression Encoder also features improved VC-1 
codecs for faster and more efficient encoding, especially when 
using multiple cores and processors.

To further refine your encoding experience, Expression Encoder 
adds the ability to add multiple source clips to your final video, 
the ability to refine nearly every key aspect of compressing 
your media, and the out-of-the-box availability of visually rich 
Silverlight 3 templates that hold your video presentation.

For a complete list of new features, see “What’s new” in the  
Expression Encoder User Guide (on the Help menu).
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Record Your On-Screen Movements

Expression Encoder includes the ability to perform screen cap-
tures. You can capture application screens or any other desktop 
element, and record any actions that you perform in those 
screens. In addition, Expression Encoder works in tandem with 
your web camera, so that you can also capture external video 
and audio as you capture your screen.

Because Screen Capture is so flexible, you can use it to create 
many types of presentations, from simple screenshot tutorials 
to fully-realized instructional videos that include screenshots 
and your voice and image. Whichever type of presentation you 
choose, Expression Encoder uses a special codec that minimizes 
CPU usage while maximizing the quality of your output, so you 
can be assured that you will be creating a high-quality file that 
will perform well in most viewing scenarios.

Once you have created your screen capture, you can open it in 
Expression Encoder for further editing and, finally, encode it for 
streaming.

For more information, see “Using Screen Capture” in the  
Expression Encoder User Guide.
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1	 Screen capture toolbar 
Use this toolbar to access all 
the options for setting up the 
video and audio preferences 
for your capture. You also initi-
ate capture from this toolbar.

2	 capture Area
Drag a bounding outline 
around the area that you want 
to capture. You can capture 
a specific region, or you can 
capture an entire window or 
screen.

3	 Preview and adjust the 
captured image
Once you have captured the 
image, you can adjust its re-
gion. You can also send it to 
Expression Encoder for further 
editing.
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Encode Media Using H.264 Compression 
(Expression Encoder with IIS Smooth Streaming only)

Expression Encoder includes extensive tools for customizing 
your H.264-compressed media. H.264, or MPEG-4, is an indus-
try standard for compressing high-quality video that you can 
play in a wide variety of scenarios, from the web to your mo-
bile device or MP3 player. When you are compressing your file 
as H.264 in Expression Encoder, you are not confined to default 
compression settings. Instead, you can adjust many compres-
sion parameters to control the complexity of the encoding job. 
These are in addition to the usual set of parameters that you 
can control, including bit rate and video size. As you experi-
ment with settings, you can use the A/B Compare feature to 
compare the results of different settings with each other. In the 
end, you can pick the H.264 settings that look best.

You can also use H.264 encoding for adaptive streaming sce-
narios. Adaptive streaming technology enables your content 
to be played back smoothly even in situations where the 
bandwidth is low.

For more information, see “Set H.264 options” in the Expression 
Encoder User Guide.
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1	 H.264 encoding options
Set precise H.264 encoding 
options to set exactly how you 
want your media compressed.

2	 video encoding
Once you have set your 
options, encode your video.

3	 transferred Content
Once you are finished encod-
ing, publish your H.264 content 
to the web directly from 
Expression Encoder, or use 
other software to transfer your 
content to a mobile device.
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Encode with New Silverlight Templates

Expression Encoder includes new Silverlight templates that you 
can apply to your encoded videos. These templates provide a 
graphically innovative and pleasing viewing environment, and 
also provide your users with tools to interact with your video 
content. You can use the tools in Expression Encoder to build 
your Silverlight experience by setting navigational markers in 
your video, creating captions, and experimenting with encod-
ing profiles to find the one that best suits your audience. Then, 
not only can you choose the appropriate Silverlight template, 
but you can also control your audience’s download experience 
by setting the video to automatically cue when the user loads 
your web page, or by setting the video to start automatically 
once it is cued.

The Silverlight templates were created to give you an easy way 
to create an appealing and functional Silverlight experience 
without needing to build your own skins. If you want to cus-
tomize the templates, however, Expression Encoder provides 
the source code for them, so that you can fully edit them using 
Expression Blend.

For more information, see “About Silverlight templates” in the 
Expression Encoder User Guide.
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1	 template options
In the Job Output category, 
preview and choose a template 
that suits you. If you like, you 
can also open this template in 
Expression Blend for editing.

2	 playback options
Set the Job Output options to 
control the playback behavior 
of your video, including speci-
fying whether the video plays 
automatically and whether the 
user can play the video offline.

3	 The video in a Silverlight 
template
Once you are finished encod-
ing, your browser launches 
to play back your video in a 
Silverlight template, just as 
your viewers will see it.
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Add Multiple Clips to the Timeline

With Expression Encoder, you can build a single timeline that 
is made up of several separate media files. With this feature, 
you can add any number of additional sources to your orig-
inal source, thereby adding scenes to your video or audio 
productions.

 

The multiple clip feature integrates well with Silverlight tech-
nology. For example, after you add multiple clips to your video, 
you can, at each cut, assign a marker thumbnail represent-
ing the content of that clip segment. Then, you can encode 
your content to a Silverlight template that supports thumb-
nail navigation. After that, on playback, those thumbnails that 
you designated will be displayed as visual chapter markers that 
your viewers can click to navigate through your video. With just 
a few markers, you can create a highly interactive, streaming 
video presentation.

For more information, see “Add multiple clips to the Timeline” 
in the Expression Encoder User Guide.
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1	 CLIP EDITS CATEGORY
Use the features here to add 
additional audio or video clips 
to your source clip.

2	 arrangement of Clips
Completely rearrange the order 
of your added clips by chang-
ing their hierarchy here.

3	 TIMELINE showing 	
ADDED CLIPS
On the Timeline, view the cut 
points and the name of every 
clip that you add.

4	 THE FINAL Product
Once you finish encoding your 
media, all your multiple sources 
are present in a single clip.
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Enhance Video with IIS Smooth Streaming
 
You can use Expression Encoder to create streaming con-
tent that fully utilizes IIS Smooth Streaming technology. IIS 
Smooth Streaming is the Microsoft implementation of adaptive 
streaming technology, which enables a video to be encoded 
in varying bit rates, and on playback, to stream in “chunks.” In 
Expression Encoder, you can create and customize any num-
ber of streams of different bit rates. During playback, the 
Silverlight client determines the amount of bandwidth available 
for the content, and depending on availability, plays back only 
the stream encoded in the bit rate that is best suited for the 
viewer’s bandwidth availability. When bandwidth availability 
improves, the playback client switches to a higher-quality ver-
sion of the stream, so that in any scenario, the client is getting 
the highest quality playback available. You can apply the adap-
tive streaming profile to any video source that you can import 
into Expression Encoder.

If you post your content to a computer running Windows 2008 
Server with IIS 7.0, and you have the IIS Smooth Streaming 
plug-in, you can encode your videos for optimal playback in 
Silverlight clients, even in scenarios in which the viewer’s band-
width can fluctuate.

For more information, see “IIS Smooth Streaming” in the 
Expression Encoder User Guide.
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1	 IIS Smooth streaming 	
output format
As you set your profiles, choose 
IIS Smooth Streaming as your 
output format.

2	 High-definition IIS 
smooth streaming 
playback
With IIS Smooth Streaming, 
your audience can now view 
uninterrupted, high-quality 
video, despite fluctuations in 
bandwidth.

3	 streaming information 
for Your video
As your video streams, you can 
click a Silverlight control to see 
the status of your bandwidth 
and how IIS Smooth Streaming 
is adjusting your video to 
compensate.
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Broadcast on the Fly with Live Encoding

By using Live Encoding in Expression Encoder, you can encode, 
stream, and save a broadcast as you create it. You can also set 
up any number of live audio and video sources, cue up existing 
content, and begin a live broadcast that can include captions. 
You decide how complex it will be, and Expression Encoder will 
handle the rest.

Optimize Playback Using VC-1 Codecs

The VC-1 codecs in Expression Encoder represent the latest in 
interlaced and progressive frame-rate encoding. They provide 
high-quality compression at both low and high bit rates, so 
that even in low-bandwidth playback scenarios, you can be 
assured that your content will look as good as it can, and will 
play smoothly.
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Use Presets to Set Your Encoding Options

To help you work rapidly and with the highest quality settings 
for your encoding scenario, Expression Encoder includes pre-
sets that you can quickly apply to any content that you import. 
Using these, you can rapidly create high-quality content, and 
apply the same settings to any number of files. You can also 
save your custom settings as presets that you can apply repeat-
edly to future content.

Enrich Your Video with Subtitles and Overlays

You can enliven or brand your content by adding subtitles and 
overlays, which are video images that appear on top of your 
original image. Expression Encoder supports both transparent 
and motion overlays. You can also use the Script Commands 
feature to create captions that will appear and fade when 
you specify.
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Welcome to  
Expression Design 3
 

Expression Design is an application for creative professionals 
and developers who want to build graphics for application user 
interfaces, the web, or any other medium.

The convenience and ease of editing vector graphics in 
Expression Design can be a cornerstone of your Windows 
Presentation Foundation (WPF) application or Microsoft 
Silverlight website. 

Whether you’re a veteran professional illustrator, a designer 
building a website, or a budding artist experimenting with vari-
ous styles and techniques, Expression Design can help you ac-
complish your creative tasks.

For a complete list of features, see “What’s new” in the  
Expression Design User Guide (on the Help menu).
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Import Photoshop and Illustrator files

You can import an Adobe Photoshop (PSD) or Adobe Illustrator 
(AI) file into Expression Design in four different ways: 

Using the Import commands.

Opening the PSD or AI file directly.

Dragging the file into Expression Design using Windows 
Explorer.

Dragging the file into Expression Design from the desktop.

You can import Photoshop files as single layers, groups, or 
Photoshop layers.

For more information, see “Import Photoshop and Illustrator 
files” in the Expression Design User Guide.

•

•

•

•
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1	 Preview Pane
In the preview pane, view the 
PSD file as it will appear on the 
artboard in Expression Design.

2	 Zoom and Pan
Use the zoom control to see 
more detail in the PSD file that 
you want to import. Move the 
cursor into the preview pane to 
pan the previewed PSD file.

3	 Layers in the panel
Import layers as individual 
images that are editable in 
Expression Design as text or 
vector objects. You can also 
import Photoshop layers, as 
well as layer groups if the file 
includes Photoshop groups.

4	 Compatibility layer
Include a layer that represents 
all layers merged into one. 
Optionally, merge layers and 
import the layers as a single 
image file.
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Slice Up Your Artwork

With the Slice tool, you can create and export stand-alone sec-
tions (slices) of your artwork from anywhere in your file. You 
can hide the objects or layers that you do not want to appear in 
each slice. For example, if you use Expression Design to create a 
mockup of a user interface for an application, you can slice up 
each part of the user interface and export the parts as XAML 
files that will be converted into user controls in Expression Blend. 
As another example, you can create multiple slices that display 
the same parts of your artwork, and then configure different 
export properties for each slice to export the artwork in multiple 
file formats (PNG, XAML, and so on).

Slices you have created appear as layers in the Slice Layer 
section of the Layers panel. For more information, see “Slices 
overview” in the Expression Design User Guide. 
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1	 Slices on the artboard
You can use the Slice tool to 
draw a slice over an object or 
a group of objects to create a 
slice. A blue bounding box iden-
tifies your slice areas on the 
artboard.

2	 Slice preview
The slice preview in the 
Properties panel shows slice 
properties and options, such as 
slice name, file format, and color 
mode, for the selected slice.

3	 Slice Layers
Each time you create a new slice 
on the artboard, a new layer 
appears under Slice Layer in the 
Layers panel to represent the 
content of your new slice.
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Exporting for Silverlight and WPF

At any point, you can export your work (whether a path, a slice, 
a selection, or the entire document) as a XAML file that you 
can then add to a Microsoft Silverlight or Windows Presentation 
Foundation (WPF) project in Expression Blend. You can export 
the following:

The entire document as a single XAML Silverlight or WPF 
canvas document.

Selected objects as a single XAML Silverlight or WPF canvas 
document.

Slices of your artwork as individual XAML Silverlight or WPF 
canvas documents.

Slices of your artwork as individual XAML Silverlight or WPF 
canvas objects in a single XAML Silverlight canvas document.

Slices of your artwork as individual images in a XAML Silver-
light or WPF canvas document.

You can also modify export properties (including object names, 
image formats, color modes, and text layers) to create the 
XAML file that best suits your needs. 

For more information, see “Export and print” in the Expression 
Design User Guide.

•

•

•

•

•
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1	 Preview pane
Preview the item that you plan 
to export. For example, if you 
select the Slices option, you’ll 
see a preview of each slice.

2	 Containers
Specify a container for your 
output, such as a resource dic-
tionary, WPF canvas, Silverlight 
canvas, or HTML and images.

3	 items to export
Choose the entire document, 
selected objects, or slices.

4	 Export Options
Specify the properties that you 
want (for example, name, for-
mat, and color mode) for your 
exported file.
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Cycle through open web pages CTRL+TAB

Preview a web page in a browser F12 or CTRL+SHIFT+B

Display a page in SuperPreview SHIFT+F12

Move through Code, Design,  
and Split views

CTRL+PAGE DOWN or  
CTRL+PAGE UP

Select a Snapshot browser size I

Select a Snapshot browser B

Connect to publishing destination CTRL+ALT+C

Disconnect from publishing destination CTRL+ALT+D

Add publishing destination CTRL+ALT+A

Stop the publishing operation in progress CTRL+ALT+X

Change the Publishing Settings CTRL+ALT+S

Publish files to the publishing destination CTRL+ALT+P

Get files from the publishing destination CTRL+ALT+G

Synchronize files (between the publishing 
source and the publishing destination) CTRL+ALT+Y

Insert a hyperlink CTRL+K

Quick tag editor CTRL+Q

Go to line CTRL+G

Insert code snippet CTRL+ENTER

Insert end tag CTRL+PERIOD

Insert start tag CTRL+COMMA

Insert HTML comment CTRL+/

Complete word CTRL+SPACEBAR

Select tag and its contents CTRL+SHIFT+COLON ( : )

Find matching tag CTRL+SEMICOLON ( ; )

Keyboard Shortcuts for Expression Web
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Open a web page CTRL+O

Add a new browser slot CTRL+N

Select baseline browser view 0

Select comparison browser view slots 
1 to 7 1-7 for matching slot

Clear baseline browser CTRL+DEL

Clear selected browser DEL

Select the URL address bar ALT+D or F4

Refresh the display CTRL+R or F5

Toggle ruler display R

Toggle DOM view display O

Toggle lights-out display L

Toggle the thumbnail preview display T

Toggle guide display CTRL+SEMICOLON ( ; )

Select vertical split layout view A

Select horizontal split layout view S

Select overlay view D

Select single browser view F

Select selection mode V

Select panning mode H

Select browser size I

Zoom to 100% CTRL+1

Zoom to fit page CTRL+0

Zoom in CTRL+PLUS SIGN or PLUS SIGN

Zoom out CTRL+MINUS SIGN or MINUS SIGN

Pan the browser views SPACEBAR+arrow keys

Keyboard Shortcuts for SuperPreview
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Save a copy of the solution or site CTRL+SHIFT+P

Cycle through Design, XAML, and Split views F11

Pan the workspace Hold down SPACEBAR

Zoom in CTRL+EQUAL SIGN

Zoom out CTRL+MINUS SIGN

Fit all to the screen size CTRL+0

Fit the selection to the screen size CTRL+9

View the artboard at actual size CTRL+1

Show or hide handles F9

Show or hide object boundaries CTRL+SHIFT+H

Edit the text in a control F2  (ESC to exit)

Edit a UserControl CTRL+E

Make the selected objects the same width CTRL+SHIFT+1

Make the selected objects the same height CTRL+SHIFT+2

Make the selected objects the same size CTRL+SHIFT+9

Keyboard Shortcuts for Expression Blend
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Flip the selected object horizontally CTRL+SHIFT+3

Flip the selected object vertically CTRL+SHIFT+4

Auto-size width CTRL+SHIFT+5

Auto-size height CTRL+SHIFT+6

Group objects into layout container CTRL+G

Ungroup objects CTRL+SHIFT+G

Bring to the front CTRL+SHIFT+CLOSE BRACKET ( ] )

Bring forward CTRL+CLOSE BRACKET ( ] )

Send to the back CTRL+SHIFT+OPEN BRACKET ( [ )

Send backward CTRL+OPEN BRACKET ( [ )

Pin active container CTRL+SHIFT+D

Make a clipping path CTRL+7

Release a clipping path CTRL+SHIFT+7

Make a compound path CTRL+8

Release a compound path CTRL+SHIFT+8

Lock selection CTRL+L

Unlock all objects CTRL+SHIFT+L

Show selection CTRL+T

Hide selection CTRL+3

Keyboard Shortcuts for Expression Blend
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Add a new item to the project CTRL+N

Add an existing item to the project CTRL+I

Add a reference to a DLL ALT+SHIFT+R

Build the project CTRL+SHIFT+B

Run the project or site F5

Make a UserControl from the selected 
objects F8 (CTRL+E to edit)

Create an annotation CTRL+SHIFT+T

Switch between workspaces F6

Reset the current workspace CTRL+SHIFT+R

Show or hide the Results panel F12

Show or hide panels (AutoHide) F4 or TAB

Show the Assets panel  
(from the Tools panel) CTRL+PERIOD

Cycle through open documents CTRL+TAB

Temporarily use the Selection tool  
(while a different tool remains selected) Hold down CTRL

Constrain proportions of objects Hold down SHIFT

Rotate an object in 15-degree increments Hold down SHIFT

Nudge objects arrow keys

Duplicate an object Hold down ALT and drag the 
object you want to duplicate

Reparent an object Drag the object over a layout 
panel and press ALT

Keyboard Shortcuts for Expression Blend
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Keyboard Shortcuts for SketchFlow
Build and play a SketchFlow project F5

Show or hide panels (AutoHide) F4 or TAB

Show or hide the Results panel F12

Show or hide the SketchFlow Map panel SHIFT+F12

Show Assets panel  
(from the Tools panel) CTRL+PERIOD

Cycle through open documents CTRL+TAB

Close all other open documents CTRL+ALT+W

Reset the current workspace CTRL+SHIFT+R

Pan the workspace Hold down SPACEBAR

Zoom in CTRL+SHIFT+PLUS SIGN

Zoom out CTRL+SHIFT+MINUS SIGN

Fit all to the screen size CTRL+SHIFT+CLOSE BRACE ( } )

Fit the selection to the screen size CTRL+SHIFT+OPEN BRACE ( { )

Create an annotation CTRL+SHIFT+T

Make into component screen SHIFT+F8

Rename a screen in the SketchFlow Map SHIFT+F2

Delete a screen in the SketchFlow Map SHIFT+DEL

Move one frame to the left  
(SketchFlow Animation panel) LEFT ARROW

Move one frame to the right  
(SketchFlow Animation panel) RIGHT ARROW

Pan the SketchFlow Map Hold down SPACEBAR

Create a navigation screen CTRL+SHIFT+I

Create a component screen CTRL+SHIFT+K
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Keyboard Shortcuts for Expression Encoder

Import CTRL+I

Encode CTRL+E

Cancel encode ESC

Set in trim point CTRL+SHIFT+I

Set out trim point CTRL+SHIFT+O

Move playhead to in point CTRL+COMMA

Move playhead to out point CTRL+PERIOD

Add marker CTRL+M

Delete selected marker CTRL+DEL

Update selected marker time CTRL+U

Clear markers CTRL+ALT+SHIFT+DEL

Add script CTRL+SHIFT+M

Remove script CTRL+SHIFT+DEL

Update script time CTRL+SHIFT+U

Add source at start CTRL+L

Add source at end CTRL+T

Add source at playhead CTRL+G

Add Audio Overlay CTRL+SHIFT+A
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Enter or exit Live Encoding Mode CTRL+H

Load settings CTRL+O

Save settings CTRL+S

Add live source CTRL+L

Add file source CTRL+F

Start broadcasting CTRL+E

Cancel broadcasting ESC

Play live source 1…9, or 10 CTRL+1...9, or CTRL+0 to 
play live source 10

Play file source 1…9, or 10
CTRL+SHIFT+1...9, or 
CTRL+SHIFT+0 to play file 
source 10

Enter or exit A/B Compare mode CTRL+K

Build preview (A/B Compare mode) CTRL+B

Cancel build preview (A/B Compare mode) CTRL+SHIFT+B

Reset workspace CTRL+SHIFT+R

Show or hide panels (AutoHide) F4

Keyboard Shortcuts for Expression Encoder
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Keyboard Shortcuts for Expression Design

Import image CTRL+I

Export CTRL+E

Adjust document size CTRL+ALT+P

Adjust artboard size CTRL+ALT+C

Turn on Pixel Preview CTRL+ALT+Y

Copy XAML CTRL+SHIFT+C

Create a slice from current selection CTRL+SHIFT+K

Paste in front CTRL+F

Paste in back CTRL+B

Paste with layer CTRL+ALT+L

Group CTRL+G

Ungroup CTRL+SHIFT+G

Repeat last transform CTRL+D

Bring to front CTRL+SHIFT+CLOSE BRACKET ( ] )

Bring forward CTRL+CLOSE BRACKET ( ] )

Send backward CTRL+OPEN BRACKET ( [ )

Send to back CTRL+SHIFT+OPEN BRACKET ( [ )

Convert object to path CTRL+SHIFT+O

Reverse path CTRL+R

Join path CTRL+J

Close path ALT+J

Make compound path CTRL+8

Release compound path CTRL+SHIFT+8
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Learning and Community Resources

In addition to the User Guides (on the Help menu for each Expression 
product), the following content and resources are available:

Expression community website  
http://expression.microsoft.com

Expression discussion forums 
http://social.expression.microsoft.com/forums

Expression Gallery 
http://gallery.expression.microsoft.com

Expression Library 
http://expression.microsoft.com/library

Silverlight 
http://silverlight.net/Learn

Feedback and bug reporting center 
https://connect.microsoft.com/Expression

Microsoft Help and Support 
http://support.microsoft.com/oas

•

•

•

•

•

•

•
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